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Welcome to WISE-FTP!  

WISE-FTP is an FTP client - a software which enables users to 
connect to any FTP server for the upload and download of files.  

Using WISE-FTP, file management is quick and easy, and no 
knowledge on how the FTP protocol works is required. This makes 
WISE-FTP an ideal tool for webmasters who update their sites 
regularly. 

WISE-FTP can connect to any valid site without being bound to a 
specific server operating system. A broad spectrum of operating 
systems is supported, e. g. Windows, OS/2, and UNIX standards. 

The basic features of WISE-FTP include:  

• Connecting to any FTP server.  

• Searching through files and/or directories on the remote 

system, as well as on your local system.  

• Moving or copying files or directories from your local system 

to the remote server, and vice versa. 

• Saving connection settings, so that frequently used FTP 

servers are accessible with just one mouse click. 

• Synchronizing content of directories on your local and remote 

system, so that, for example, your website is always up-to-

date without having to copy individual files. 
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Updates  

Update Manager enables you to keep your software always up-to-
date! Via the Internet, Update Manager automatically checks 
whether newer versions of WISE-FTP are available.  

Use this command regularly to ensure that you are always working 
with the most current version. 

If problems occur, make sure no antivirus software or firewalls are 
active which might stop Update Manager from connecting to the 
Internet. If further problems occur, download product updates 
manually from the WISE-FTP website.  

From the File menu, select Live Update to start the Update 
Manager.  

NOTE: Only free updates are installed. 
 

http://www.wise-ftp.com/
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Basics 

What is FTP? 

FTP (File Transfer Protocol) is an Internet service used to connect 
to a special server on the Internet, either to transfer files from the 
server to the local system (download) or to send files to the server 
(upload). In addition, the FTP protocol implements commands to 
execute operations on a remote system, e. g. view directories, change 
directories, make directories or delete files.  

FTP is based on the client/server principle: a computer runs a server 
program which "serves" data to other computers. These other 
computers execute client programs which request information from the 
server and receive its answers. Under FTP, the remote computer - 
seen from the client's point of view - running the server program is 
referred to as  FTP server (host, remote system).  

Companies, organizations, and other providers often make files and 
information of public interest available on an FTP server. To access 
such FTP servers, users require Internet access (via modem, ISDN or 
a local network) and an FTP client (as for example WISE-FTP). 

  

What is SFTP? 

SFTP stands for Secure File Transfer Protocol. The Secure File Transfer 
Protocol provides secure file transfer functionality over any reliable 
data stream, SSH in this case. It is the standard file transfer protocol 
to use with the SSH2 protocol. WISE-FTP implements client side of 
this protocol which is reliable and easy to use.  

SFTP protocol is designed to provide primarily file transfer, but also 
more general file system access on the remote server - in secure 
manner. SFTP protocol assumes it is running on secure channel, thus 
no plaintext passwords or file information is exposed to the network. 
WISE-FTP supports the most important PutFile (for file uploading) 
and GetFile (for file downloading) methods, but also 

• MakeDir and RemoveDir to create and delete directories  

• DeleteFile to delete files on the server  

• ListItems event to list files in some directory on remote server  
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• GetAttributes and SetAttributes to retrieve and set attributes 

for the file or directory  

• Resume property to resume broken transfers  

• Blocking mode to execute methods and wait until they are 

completed  

• Password and PrivateKey properties that determine type of 

authentication with the server  

• ASCII and Binary file transfers to handle different data types  

• Done event that is fired when executed method is completed   

WISE-FTP works with all OpenSSH versions, as well as SSH (from 
SSH Communications Security Corp.) which are most common on 
today's servers, but has also been tested on others too. Different 
server implementations handle some sftp features differently (for 
example, some add "/" to the end of each directory name) but WISE-
FTP has no problems with those.  

 

Fingerprints 

As SSH architecture does not know certificates or other ways to check 
if the remote server is the server you expect to be for connection, it is 
a matter of "trust" if you accept connection or not. 

SSH normally works like this:  once you connect to a remote server 
and you are sure that this is the server you wish to connect to, you 
should save fingerprint information locally. For each new connection, 
you should check, if the fingerprint information is the one you stored - 
to make sure that nobody is in the "middle". Fingerprint information is 
almost unique for different servers and is generated from the private 
key of the server. 

 



Basics 

7 

What is an FTP site? 

An FTP site is based on a server program running on a so-called "host" 
computer. Many companies and organizations offer, for example, 
downloadable shareware versions of their software on public FTP 
servers.  

If you are logged onto such a server and you cannot find the desired 
information, look for a file named, for example, readme, readme.txt, 
ndex or 00index. These files usually contain important information 
about the files available on the server. These FTP sites are usually 
public sites. You may simply log in with the user name anonymous; 
and enter your email address as password. 

Other, password-protected, servers allow users to upload files 
themselves. This way websites may easily be updated and extended.  

 

What is an IP address? 

An IP address is a unique identifier which defines the location of a 
computer on the Internet. It also gives information on the used 
provider. IP addresses are 32-bit addresses composed of four 
separate numbers from 1 to 255, separated by dots (.). 

Every IP address is mapped to a special host name, as most users 
find it easier to remember names than to remember numbers.  

Any address starting with http:// or ftp:// is simply a masked IP 
address. WISE-FTP accepts IP addresses, as well as host names.
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Working with WISE-FTP 

Connect 

Connect to FTP site  

To connect to an FTP site, click the  Connect button. Then the 
Site Manager dialog box opens, where you enter a user name and 
password to log onto an FTP site. . 

For servers which allow anonymous login, type in anonymous as user 
name and your email address as password. To test these settings, 
you might try to connect to ftp.hello-engines.com.  

To log onto private sites, which, for example, support file upload, a 
predefined ID/password combination, and sometimes a special account 
number is needed. Such sites are normally used to share corporate 
information with other users or to manage websites. Contact your web 
space provider for the necessary login information. 

Before connecting, create new server profile. 

To use an existing connection, select File/Connect and click Connect.  

 

Create new FTP site 

To create a new site, proceed as follows: 

1. From the Tools menu, select  Site Manager and click 

New Site .  

2. Type in a meaningful name for the site.  

3. Type in the FTP address of the server you want to connect to. 

Make sure it contains no ftp:// or http://.  

4. Type in your user name, or anonymous if you want to log in 

as guest. Usually, user names are case sensitive!  

5. Type in your password. Passwords are case sensitive, too!  
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6. In the Proxy field, set the proxy settings. If you uncheck Use 

global proxy configuration, you need to type in the proxy 

address and proxy port. 

7. Type in path to initial directory, e. g. to the directory your 

web pages are stored in (optional).  

8. Activate or deactivate Passive transfer. 

9. Type in comments describing the project (optional).  

 

Select authentication method 

To make sure that you are connecting to the right server, you can 
select an authentication method, if you have chosen SFTP as 
connection type. 

1. From the Tools menu, select  Site Manager to open the 

Site Manager dialog box.  

2. As connection type select SFTP, and click the Advanced 

button to open the Authentication Method dialog box. 

3. You can now select either a password, a public or private key. 

4. If you like to define both, check option Both. 

5. Enter a password in the Passphrase field, and / or browse 

for the private key file. 

6. Click OK to close the dialog box. 
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SSH Keypair Generator 

Using the SSH Keypair Generator, you can create the key for SFTP 
connection. To do so, select Tools/SSH Keypair Generator and 
enter the following: 

• Key type: Here you select the authentication log. You can 

choose between RSA and DSA. 

• Key bitcount: Enter here the desired bit count. 

• Passphrase: Here you enter a passphrase. 

• User name: Enter the user name. 

• Private key filename: Here you determine the file for the 

private key. 

• Public key filename: Here you determine the file for the 

public key. 

 

NOTE: The advantage of using these key-based authentication 
systems is that in many cases, it is possible to establish secure 
connections without having to manually type in a password. 

 

Manage sites 

To change an existing site, select desired name in the left part of the 
window, and type in changes in the right part.  

Click Save to save changes. If you close the dialog box now or connect 
to the site, you have to confirm changes. Click Cancel to reset 
changes. 
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Quick connection 

By clicking the  Quick Connection button from the toolbar, you can 
quickly and easily connect to an existing FTP site.  

In the dialog box that displays enter the FTP server to which you wish 
to connect. 

It is also possible to type in a new FTP address, login will then be  
anonymous.  

 

Disconnect 

By clicking the Disconnect button  you disconnect from a remote 
system.  

Every client logged onto a remote system (e. g. WISE-FTP) reduces 
server performance - no matter if data is transferred or not. Do not 
stay connected to a server longer than necessary (other users will 
appreciate it). Some servers disconnect automatically after a certain 
period of time if the client sends no commands. WISE-FTP can be 
configured to disconnect at idle after a certain period of time. 

 

Restore connection  

If a connection attempt has failed the FTP server might be busy. 
WISE-FTP is able to retry connection after a certain period of time.  

Open dialog box Options and click on Connection/Transfer. Type in 
desired value under Wait between attempts (secs.).  

 

Anonymous login 

Usually, you log onto an FTP server with a user name and password. 
Nevertheless, many sites offer a guest login. Type in anonymous as 
user name and your email address as password.  
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FTP servers supporting anonymous login usually allow users to 
download files which are publicly accessible without restriction, e. g. 
shareware programs, image collections, help texts, etc. 

Note that there is a special etiquette for public servers:    

• Do not stay connected longer than necessary to avoid that 

server performance is reduced.  

• Do not download too many files.  

• Read the "readme" files which are found in most directories; 

they contain information on the directories' content.  

A further characteristic of such (public) servers is that users may view 
and download files, but not upload them.  
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Transfer data 

Transfer files or folders 

To transfer files or folders, proceed as follows: 

1. Make sure drag-and-drop is activated in the Advanced tab of 

the Options dialog box. 

2. Open remote directory to transfer items to. 

3. Select transfer mode (ASCII, Binary or Auto) on panel below 

file lists.   

4. Select file(s) or folders for upload. Use CTRL key to select 

several items. 

5. Possible ways to upload items:  

 

Drag item and "drop" it on target directory.  

 

Click on the transfer arrow pointing to the right.  

 

From the Transfer menu, select Upload. 

 

Transfer arrows 

The four arrows on the Transfer panel (center) simplify up- and 
download.  

Use the arrows pointing to the left to download selected files or folders 
to your local system.  

Use the arrows pointing to the right to upload selected files or folders 
to the remote system. 
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Queue 

All connections initiated by the user are listed under Transfer 
progress in the lower part of the Main Window as long as they are 
either completed or cancelled by the user. You can resort all elements 
by clicking on the column titles. A second click reverts sorting. 

To show or hide this section use View/Transfer progress. 

In the Options dialog box under Connection/Transfer, you can 
specify which columns should be displayed and which not.  

 

Transfer modes 

Files can be transferred in two different modes: ASCII or binary. Auto 
mode follows a predetermined rule and transfers selected file types in 
desired mode. 

 

ASCII mode 

Always transfer pure text files, e. g. .txt, .html, .htm, .cgi, in ASCII 
mode.  

WARNING: Transferring a binary file in ASCII mode may damage 
the file. 

 

Binary mode 

Always transfer image files, executable files or ZIP archives (.bmp, 
.jpg, .exe, .zip) in binary mode. Also use this mode for unknown file 
types, or such extensions not registered under Windows. 

 

Automatic 

If Auto is activated: WISE-FTP checks whether the file extension is 
listed under Options: File Types.  

• If listed, file is transferred in ASCII mode. 
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• If not listed or if file has no extension, file is transferred in 

binary mode. 

If Auto is deactivated: File is transferred in desired mode (binary or 
ASCII). 

 

ASCII mode 

Use ASCII mode to transfer text files (e. g. .txt, .html, .htm, .cgi). 
The end-of-line character depends on the type of computer. Use 
ASCII mode to make sure, end-of-line characters are translated 
correctly.  

HINT: If you are sure that local and remote system use the same 
operating system, you can do without ASCII mode, and always 
transfer in Binary mode.  

 

Binary mode 

Use Binary mode to transfer files which are not pure text files (e. g. 
.txt, .html, .htm, .cgi). Executable programs, word-processing 
documents, databases, image and audio files are only a few examples 
of files which have to be transferred in Binary mode.  

HINT: If you are sure that local and remote system use the same 
operating system, you may always transfer in Binary mode.  

 

Transfer protocol 

The protocol FTP (File Transfer Protocol) serves as a communication 
interface between FTP client (e. g. WISE-FTP on your local system) 
and the FTP server. 

This communication is based on predefined FTP commands (from the 
client) and server "replies".  

You do not have to know anything about this "language" to understand 
WISE-FTP! All menu options, dialog box prompts, and mouse 
movements (Drag-and-drop) are "translated" automatically and server 
replies are processed correctly.  
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After every startup, the log is displayed below the Main Menu bar. To 
show or hide the log use View/FTP Log. 

Nevertheless, if you are interested in the way the protocol works or 
need to correct mistakes, it is possible to save the log in a text file. 
The log window is cleared at every startup; make sure you save the 
log before exiting WISE-FTP.  

To save the log, select Save Log As... from the Tools menu. 

 

Passive transfer 

In passive mode FTP, the client initiates the connection to the server 
to solve the problem of firewalls. During an FTP connection the client 
opens two unprivileged ports locally (N> 1024 and N+1). The first port 
contacts the server on port 21, but instead of giving a port command 
and allowing the server to connect to its data port again, the client 
gives the PASV command. As a result, the server opens an 
unprivileged port (P>1024) and sends the port P command back to the 
client. The client then initiates the connection from port N+1 to port P 
on the server to transfer data. 
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Manage files and folders 

Properties 

By clicking the Properties button, the Properties dialog box displays.  

View detailed file information, e. g. on attributes or read and write 
access. You may change access right for files and directories on a 
UNIX FTP server, if you have the necessary access privileges.  

 

View file 

To view the content of file, select a file, click the  Quick view 
button.  

File content is either displayed by the internal viewer or by the 
Windows program registered for this file type.  

If under Options: General check box Use internal viewer is 
activated, all file types listed under Options: File Types will be 
viewed with the internal viewer. 
 
If check box Use internal viewer is deactivated, WISE-FTP will 
always use the Windows program registered for this file type.  
  

NOTE: All files viewed with Quick View will be saved in the subfolder 
Quickview of WISE-FTP's program folder. You can empty this 
directory unhesitatingly to release disk space.  

 

Sort files and folders 

Sort listed files and folders using the column titles (name, date, size).  

Click on the column titles Name, Size or Date to sort list according to 
desired field (a second click reverts sorting order).  
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Move files 

When moving a file, WISE-FTP copies it to a different directory and 
deletes the original file from the source directory.  

You may move files between remote directories, if you have the 
necessary access rights.  

To move files, proceed as follows: 

1. Select a file and drag-and-drop it on the target directory. The 

directory must be on the same server. 

 

Or: 

2. Right-click on selected file and choose the desired directory 

from the pop-up menu. 

3. Then select the directory to which you wish to move the file. 

 

Move folders 

When moving a folder, WISE-FTP copies it to another directory and 
deletes the original folder in the source directory.  

You may move folders between remote directories if you have the 
necessary access rights.  

To move folders, proceed as follows: 

1. Drag folder and "drop" (drag-and-drop) it on target directory. 

The directory must be on the same server.  

Or: 

2. Right-click the folder you want to move and choose Move 

folder to...  from the pop-up menu.  

3. Now choose the directory you want to move the folder to.  
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Rename 

Use the Rename button to change file names on local or remote 
system. 

This feature is only available, if you have the necessary access rights 
for this site.  

 

Delete files 

Proceed as follows if you wish to delete remote files (this feature is 
only available, if you have the necessary access rights):  

1. Select item.  

2. Then click the Delete button.  

 

Folder content 

Display content of active FTP folder as text. Enables, for example, 
copying or printing the list. In addition, access rights for all files are 
listed. 

1. Select folder. 

2. Right-click to open pop-up menu.  

3. Select Folder Content.  

 

Create new folder 

If you have the necessary access rights, you may create a new folder 
on the FTP server. 



Working with WISE-FTP 

21 

• From the Commands menu, select New Folder and type in 

desired name. 

 

Or: 

• Right-click on the upper directory tree of the remote system 

and select New Folder from the pop-up menu. 

 

Rename folder 

Rename folders on your local or the remote system. This feature is 
only available, if you have the necessary access rights. 

1. Select folder to be renamed.  

2. From the Commands menu, select Rename Folder, or click 

the toolbar symbol.  

3. Type in desired name and confirm with OK.  

 

Delete folder 

If you have the necessary access rights, you may delete folders on the 
FTP server. To do so, proceed as follows: 

1. Select the desired folder, and choose option Delete Folder 

from the Commands menu. 

2. If no folder is selected when clicking Delete Folder, you are 

prompted to type in a folder name. 

If a folder contains files, you may only delete it, when option Allow 
deletion of directories containing files is selected from the 
Options dialog box, Advanced tab.  
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Delete directories containing files 

An empty directory may be deleted at any time. To delete a directory 
which is not empty do the following:  

1. Open Options dialog box .  

2. Select tab Advanced.  

3. Activate Allow deletion of directories containing files.  

 

Synchronize folders 

This feature enables you to synchronize folders on your local and the 
remote system. This might be helpful if you have edited local files, and 
you do not want to upload them individually.  

 

Drag-and-drop 

Use the drag-and-drop technique, well-known from Windows, to 
transfer files and folders. 

Under Options, make sure drag-and-drop is activated. From the 
Options menu in the main window, select tab Advanced. Activate 
option Enable drag-and-drop for folders.  

This enables you to:  

• drag files and folders from the left (local) part of the Main 

Window to the right (remote), and vice versa.  

• drag files and folders from your desktop or any other 

Windows window to the server, and vice versa.  

• right-click a remote file to open the pop-up menu.  
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Change file access rights on a UNIX server 

Select desired file(s). From the Commands menu, open Properties. 

Access rights are expressed through three digits; for example, the 
rights expressed above correspond to 644. The first digit represents 
rights of the owner, the second rights of group members, and the third 
rights of all other users. The three digits are used in the WISE-FTP 
log, and by some system administrators and Internet providers.  

The following table indicates which options correspond to the 
respective digits. The third column gives possible values for owners, 
groups, and other users as they are displayed by a UNIX server. To 
see this file list, select Directory content. 

 

Selected option 1st, 2nd, or 3rd digit Rights according to 
file list 

None 0 -- 

Execute 1 --x 

Write 2 -w- 

Write, Execute 3 -wx 

Read 4 r-- 

Read, Execute 5 r-x 

Read, Write 6 rw- 

Read, Write, Execute 7 rwx 
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Manage sites 

Rename existing site 

A site's profile name (ideally) describes its content and topic.    

1. From the Tools menu, open Site Manager.  

2. Select site to be renamed.  

3. Type in new name under Profile name. If you close the 

dialog box now, or connect to the site, you are asked to 

confirm the changes.  

 

Add comments to existing site 

Comments can be added to every existing FTP site. This helps to keep 
track, especially of a larger number of sites.  

1. From the Tools menu, open Site Manager.  

2. Select site you want to add comments to.  

3. Add comments under Comments.  

 

Create new directory for existing site 

 

Site Manager 

1. From the Tools menu, open Site Manager.  

2. Click the arrow next to New Site and select New Directory.  

3. Type in name for new directory.  
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HINT: To create a new FTP site in a directory, make sure the 
directory is selected.  

 

Manage existing sites in directories 

WISE-FTP allows you to manage existing sites in directories with 
meaningful names. This simplifies site management (especially if the 
number of sites increases). 

It may be helpful to arrange sites in directories according to topics, e. 
g. one directory for download sites offering free games, one for 
software updates, etc. 

From the Tools menu, open Site Manager. Like in Windows Explorer, 
you may use drag and drop. Move mouse pointer over desired object, 
and drag it into desired directory with left mouse button pressed.  

 

Delete existing site 

To delete existing sites, do the following: 

1. From the Tools menu, open Site Manager.  

2. Select site or directory to be removed and click Delete.  
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Favorites 

Favorites 

The new WISE-FTP version allows you to create and manage 
favorites. 

Favorites do not need to be entered in Site Manager. Here, for 
example, you can enter public FTP servers you frequently use without 
having to enter them in Site Manager. This ensures clear site 
management. 

•   Choose Favorites from the menu bar, and then click Add to 
Favorites in order to add the current connection to the favorites.  
   

•   Click Organize Favorites to organize your favorites later.  

 

Organize favorites 

You may edit and organize your favorites at any time. 

• To edit a connection, select the connection from the lower 

window and edit the data in the upper window. For this, 

simply click the entry value and change it.  

• To create a new folder, simlpy click New Folder...  

• To rename an entry, simply click Rename.  
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WISE-FTP Scheduler 

WISE-FTP allows to automate uploading and downloading of files. 
WISE-FTP Scheduler helps you to do this. To plan a new task, click 

Create New Task . 

WISE-FTP schedule wizard opens guiding you through the creation 
of a new task in 4 steps. 

• In Step 1 , choose the desired action.  

• In Step 2 , choose a saved server profile from WISE-FTP or 

enter a new FTP server.  

• In Step 3 , choose the files to be uploaded and the target 

directory.  

• In Step 4 , specify when and how many times the task should 

be performed. 
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Explorer integration 

Explorer integration 

Explorer integration is a new function of WISE-FTP. 

In your Windows Explorer, under Network neighborhood -> Wise-FTP 
Network Places you can access your FTP server, upload files from a 
local directory to any FTP server using drag&drop or download files. 
Work with the Explorer Integration as you are used to with the 
Windows Explorer. 

 

Create new FTP site (Explorer Integration) 

Under Network neighborhood -> Wise-FTP Networkplaces, you can 
also create a new FTP site. 

From the File menu select New/Directory to create a new directory 
in which the new site is to be created. 

Click Create new... to create a new FTP site.  
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Settings and Commands 

Settings 

Options 

Customize WISE-FTP so that it suits the configuration of your system. 

Options: General 

Options: Advanced 

Options: Connection/Transfer 

Options: Firewall/Proxy 

Options: File Types 

 

Options: General 

In the Options dialog box, General tab, you can make the following 
settings: 

• Email address: Type in your email address. It is used as the 

standard password for anonymous access. This is common 

with most FTP servers which allow anonymous access. 

• Show FTP server dialog at startup: Activate this check box 

to display the Site Manager dialog box at the startup of 

WISE-FTP. You can then choose a remote site to connect to 

immediately. 

• Highlighting for FTP log: Activate this check box to display 

log messages in different colors. 

• Hide password in log: Activate this checkbox to mask 

passwords in the log. This ensures that your passwords are 

not visible in the log. 
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• Save Quick view files in: Select a directory to temporarily 

store the files you are viewing with Quick View. 

• Use internal viewer: If this check box is activated, Quick 

View uses WISE-FTP's own internal viewer to display files. 

Otherwise, Quick View will open files with the specific 

program registered for this file type under Windows. 

• Syntax highlighting: If this check box is activated, in the 

internal editor, HTML source code is displayed in different 

colors to make working with the code easier.  

• Default FTP port: Only advanced user should change the 

default setting; it is usually "21" or "ftp". 

• Use Passive mode by default: Choose this option to always 

use Passive transfer.   

• User interface language: Select the language you want to 

use in the program. Possible options are English, German, 

and French. This feature only changes the display language 

for menu options, messages, etc. Of course, it does not affect 

the way the program works.  

• Display tip of the day at program start: If this option is 

checked, you get important information on the program when 

starting WISE-FTP. 

 

Options: Advanced 

In the Options dialog box, Advanced tab, you can make the following 
settings: 
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• Double-click action: Select which action is to be performed 

if you double-click a file or a directory. 

• Sounds: Assign sounds to specific actions. 

• Enable drag-and-drop for folders: This option enables you 

to move files and directories between local and remote 

system using the drag-and-drop technique.  

• Retain file date on download: Every new file is stored with 

its specific creation date. If new files are downloaded to your 

local system, the file adopts the date it was downloaded. If 

this option is activated, downloaded files retain their initial 

date. 

• Allow deletion of directories containing files: This 

enables you to delete a directory with its entire content from 

an FTP site, if you have the necessary access rights. 

• Delete completed transfers from queue: All connections 

initiated by the user are listed under Transfer progress in 

the lower part of the Main Window. If this option is activated, 

all successfully completed transfers are deleted from the list. 
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• Hold connection at idle: If WISE-FTP has not sent 

commands to the server for a certain amount of time, the 

program disconnects automatically, because every user 

logged onto a remote system reduces server performance - 

no matter if data is transferred or not.  

 

Activate this option to hold the connection. However, some 

servers are configured to disconnect at idle. It might happen 

that a server closes the connection although you have 

activated this option. 

• Transfer only newer files at folder transfer: If you upload 

a directory and a remote directory with the same name 

already exists, data on the server is usually overwritten. 

 

If activated, only new files will be uploaded into the directory. 

Files with the same name will be overwritten if the ones 

uploaded are newer. 

• Read all folders when connected: If activated, the content 

of all directories on the FTP server will be read completely 

when connected. This might take some time. If deactivated, 

only selected directories will be read. 

• Confirm overwriting of identical or newer files: If 

activated, WISE-FTP will display a warning message - with 

possibility to cancel this action - before deleting identical or 

newer files. 
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• Monitor clipboard for FTP URLs: If this option is checked, 

the FTP URL (e.g ftp://myserver.com) is inserted 

automatically into the quick connection, if there is an URL in 

the clipboard. 

 

Options: Connection/Transfer 

In the Options dialog box, Connection/Transfer tab, you can make 
the following settings: 

• Connection retries: Type in how many times WISE-FTP 

should try to establish a connection if the first connection 

attempt fails. 

• Connection timeout (secs.): Connection timeout is the 

period of time within which WISE-FTP tries to connect to a 

remote system. If the value is exceeded, the connection 

attempt is cancelled. 

• Transfer retries: Type in how many times WISE-FTP should 

try to transfer a file if the first transfer attempt fails. 

• Wait between attempts (secs.): The period of time WISE-

FTP waits between a failed connection and the next 

connection attempt. 

• Number of simultaneous transfers: Type in how many 

files are to be transferred at the same time. Maximum value 

is 10 simultaneous transfers. 

• Warn when file exceeds KB: A warning message is 

displayed if you want to view a remote file larger than this 

value. 
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• Auto-resume interrupted transfers: Indicates whether 

interrupted transfers are to be resumed automatically.  

• Transfer headers: Here you can select the columns to be 

shown in the queue. 

 

Options: Firewall / Proxy  

In some companies and organizations, the local network is separated 
from the rest of the Internet through a firewall. If your network is 
protected through a firewall which blocks FTP transfers, you have to 
change the firewall settings, so that FTP transfers are allowed to 
"pass". Ask your network administrator for firewall settings (e. g. host 
name or IP address ). 

Enter the proxy settings for FTP, SFTP and the Update Manager 
separately.  

Under Type, select an entry according to your proxy server. If you 
have chosen FTP and SFTP you can only select FTP or SOCKS, for 
the Update Manager you can choose between http or SOCKS. 

 

Options: File types 

WISE-FTP lets you define the transfer mode to be used with every file 
extension. If transfer mode is set to Auto, all files are transferred as 
binary, unless the file extension is listed under File types. File 
extensions listed here are transferred in ASCII mode. The list contains 
the extensions of all files which will be transferred in ASCII mode if 
transfer mode is set to Auto. 

Adding a file extension to the list: 

1. Under Always use ASCII mode for files with these 

extensions: type in desired file extension. The extension 

may contain up to 9 characters, including dots. 

2. Click Add. The file extension appears in the list box on the 

left. 



Settings and Commands 

35 

3. To remove an extension from the list, select it and click 

Remove. 

 

Configuration wizard 

The Configuration wizard helps you to configure WISE-FTP. 
Experienced users may configure WISE-FTP using the Options dialog 
box from the Options menu. The Configuration wizard displays 
when starting the application for the first time. To reopen the wizard 
later, choose option Configuration wizard from the Options menu. 
Then follow the wizard's steps. If you do not know for sure which 
settings to use, use the standard values.  

 

Configuration wizard: Step 1 

In the first step of the wizard, you can make the following user 
interface settings: 

• Display tip of the day at program start: If this option is 

checked, you get important information on the program when 

starting WISE-FTP. 

• Show FTP server dialog at startup: Activate this check box 

to display the Site Manager dialog box at the startup of 

WISE-FTP. You can then choose a remote site to connect to 

immediately. 

• User interface language: Select the language you want to 

use in the program. Possible options are English, German, 

and French. This feature only changes the display language 

for menu options, messages, etc. Of course, it does not affect 

the way the program works.  

• Highlighting for FTP log: Activate this check box to display 

log messages in different colors. 
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• Hide password in log: Activate this checkbox to mask 

passwords in the log. This ensures that your passwords are 

not visible in the log. 

 

Configuration wizard: Step 2 

In the second step of the wizard, you make general settings and 
adjust WISE-FTP according to your own needs: 

• Email address: Type in your email address. It is used as the 

standard password for anonymous access. This is common 

with most FTP servers which allow anonymous access. 

• Use internal viewer: If this check box is activated, Quick 

View uses WISE-FTP's own internal viewer to display files. 

Otherwise, Quick View will open files with the specific 

program registered for this file type under Windows. 

• Enable drag-and-drop for folders: This option enables you 

to move files and directories between local and remote 

system using the drag-and-drop technique.   

• Retain file date on download: Every new file is stored with 

its specific creation date. If new files are downloaded to your 

local system, the file adopts the date when it was 

downloaded. If this option is activated, downloaded files 

retain their initial date. 

• Allow deletion of directories containing files: This 

enables you to delete a directory with its entire content from 

an FTP site, if you have the necessary access rights. 
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• Transfer only newer files at folder transfer: If you upload 

a directory and a remote directory with the same name 

already exists, data on the server is usually overwritten. 

 

If activated, only new files will be uploaded into the directory. 

Files with the same name will be overwritten if the ones 

uploaded are newer. 

• Confirm overwriting of identical or newer files: If 

activated, WISE-FTP will display a warning message - with 

possibility to cancel this action - before deleting identical or 

newer files. 

• Monitor clipboard for FTP URLs: If this option is checked, 

the FTP URL (e.g ftp://myserver.com) is inserted 

automatically into the quick connection, if there is an URL in 

the clipboard. 

 

Configuration wizard: Step 3 

In the third step of the wizard, you can change the connection 
settings: 

• Default FTP port: Only advanced user should change the 

default setting; it is usually "21" or "ftp". 

• Use Passive mode by default: Choose this option to always 

use Passive transfer.   

• Connection retries: Type in how many times WISE-FTP 

should try to establish a connection if first connection attempt 

fails. 
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• Connection timeout (secs.): Connection Timeout is the 

period of time within which WISE-FTP tries to connect to a 

remote system. If the value is exceeded, the connection 

attempt is cancelled. 

• Transfer retries: Type in how many times WISE-FTP should 

try to transfer a file if first transfer attempt fails. 

• Wait between attempts (secs.): The period of time WISE-

FTP waits between a failed connection and the next 

connection attempt. 

• Number of simultaneous transfers: Type in how many 

files are to be transferred at the same time. Maximum value 

is 10 simultaneous transfers. 

• Auto-resume interrupted transfers: Indicates whether 

interrupted transfers are to be resumed automatically.  

 

Configuration wizard: Step 4 

In the fourth step of the wizard, you can change the proxy settings for 
WISE-FTP. 

It is required to enter the proxy settings for FTP, SFTP and the Update 
Manager separately.  

Under Type, select an entry according to your proxy server. If you 
have chosen FTP and SFTP you can only select FTP or SOCKS, for 
the Update Manager you can choose between http or SOCKS. 

To use SOCKS, your proxy server needs to be a SOCKS proxy. There 
are different SOCKS types, which you can select under Socks proxy 
type. To get to know which proxy you use, contact your system 
administrator. 
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Configuration wizard: Step 5 

The wizard has completed the configuration of WISE-FTP. Click Close 
to exit the wizard. 

 

Customize keyboard 

WISE-FTP allows you to chose your own shortcuts for the most 
important program functions to make the use of the program quicker 
and easier. To create customized shortcuts, proceed as follows: 

1. From the Options menu, select Customize keyboard... to 

open the Customize keyboard shortcuts dialog box. 

2. From the Category window, select a menu or an option. 

3. The respective functions are then displayed in the Commands 

window. 

4. If you select a function, the corresponding description is 

displayed in the Description field in the lower area of the 

dialog box. In the Current shortcut field, you find the 

recently used shortcut, if available.  

5. If you wish to replace the currently available shortcut by a 

new one, click the Remove button. In the New shortcut 

field enter the new shortcut. Type in the shortcut by using 

the shortcut. 

6. Then click Assign to assign the shortcut to the function. 

7. Click OK to close the dialog box. 
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Commands 

Send commands directly to server 

 

Custom command  

This feature allows advanced users to send FTP commands directly to 
the server.  

From the Commands menu, select Custom command. 

 

Supported FTP commands (overview) 

WISE-FTP enables you to send commands to an FTP server via 
menus, dialog boxes, and mouse movements (drag-and-drop). WISE-
FTP automatically "translates" all these actions into special FTP 
commands, so that users do not need to have prior knowledge of the 
FTP protocol.  

At times, advanced users might want to type in these commands 
themselves. The File Transfer Protocol implements a total of about 35 
FTP commands plus new extensions. WISE-FTP supports the following 
10 (custom) commands: 

CHMOD  

CWD  

HELP  

LIST  

NLST  

PWD  

QUOTE  

RETR  

SITE  

STOR  

SYST  
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To send a custom command to a server, select Custom command 
from the Commands menu.  
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Tutorial 

This is what you learn in this tutorial 

In this tutorial, you learn step by step how to work with WISE-FTP. 
This tutorial consists of three parts. 

 

In the first part, you get to know how to establish connections to an 
FTP server: 

Creating new FTP site 

Connecting to FTP server 

 

In the second part, you learn how to transfer your files and folders: 

Transferring files or folders 

 

In the third part, you get to know how to edit files and folders on the 
remote server: 

Moving files or folders 

Deleting files or folders 

Creating folders 

Printing folders 
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Connecting to the server 

Creating new FTP site 

Before connecting to an FTP server, you should create an FTP site. You 
only need to follow these steps for your first connection: 

1. From the Tools menu, select option Site Manager. 

2. The dialog box Site Manager opens. 

3. Click New Site and enter the following information: 

 

Profile name: Enter a name so that you can easily find the 

site later. 

 

Host name: Enter the name of the server on the Internet. 

For example, ftp.my-website.com 

 

Port: Enter the port. For FTP connections the port is ftp, and 

for SFTP the default value is 22. Normally, you do not need to 

change this setting.  

 

Account: Here you enter your assigned account. Normally, 

you do not need to enter anything 

 

User name: Type in your user name. If you wish to log in as 

guest, enter anonymous. 

 

Password: Enter you password. If you log in as guest, type 

in your email address. 

4. Choose a connection type. If you choose SFTP you can select 

an authentication method by clicking the advanced button. 
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5. Check option Use global proxy configuration to leave the 

default proxy settings, or click the Proxy Settings button, to 

define your own settings. 

6. In the Initial folder field enter the path of an optional initial 

folder, e.g. the root directory of your website. 

7. Use the button … next to the Local folder field to select a 

folder on your local system (optionally). This folder then 

automatically opens in the Local system window. 

8. If you check the Passive check box, the passive transfer is 

activated. We recommend to use passive transfer for the 

connection. However, passive transfer is compulsory, if your 

network is saved by a firewall based on a router, or if you use 

a proxy server. 

9. Under Comments you can type in a description of the project 

(optionally). 

10. Then click Save to save the entries you made. 

11. To close the dialog box, click Close.  

 

Now that you have learned how to create an FTP site, you will learn 
how to establish a connection to an FTP server in the next section. 

 

Connecting to FTP server 

After having created an FTP site, you can now connect to a server. To 
do so, proceed as follows: 

1. Click , or select Connect from the File menu. 
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2. From the Site Manager dialog box that opens, select an 

existing server or create a new FTP site. 

 

 

 

3. Then click Connect to establish the connection to the selected 

server. 

4. You will then find details about your connection in the FTP 

Log window. 
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In the second part of the tutorial, you learn how to transfer files or 
folders. 
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Transferring data 

Transferring files or folders 

After connecting to a server, you can now start to transfer files or 
folders: 

1. From the left window, Local System, select in the Explorer 

the files or folders you wish to upload. 

2. Select transfer mode. You can choose between the following 

transfer modes:  

 

   

 

ASCII: Always use ASCII mode to transfer pure text files, 

e.g. .txt., .html, .htm, .cgi. 

Binary: Always transfer image files, executable files or ZIP 

archives (.bmp, .jpg, .exe, .zip) in binary mode. Also use this 

mode for unknown file types, or extensions not registered 

under Windows. 

Auto: If this option is activated, WISE-FTP checks whether 

the file extension is defined. If yes, file is transferred in ASCII 

mode, if not or if file has no extension, file is transferred in 

binary mode. It is recommended to primarily use this option! 

3. Then drag and drop the files to the selected folder in the 

Remote System window on the right. Note that this function 

is only available for folders, if on the Advanced tab in the 

Options dialog box, Enable drag-and-drop for folders is 

activated. 

Or: 
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4. From the right window, choose a folder and select the files to 

upload from your local system in the left window. Then click 

Upload or Upload folder if you wish to upload folders.  

NOTE: Using the function Synchronize folders from the Tools 
menu, you can equalize the contents of the local folder and the 
selected remote folder. That is to say, only new or modified files are 
uploaded. Identical files are replaced automatically. 

 

Now that you have learnt how to transfer files or folders, you get to 
know how to edit files or folders. 



Manual: WISE-FTP 3.0 

50 

Editing files and folders 

Moving files or folders 

In this section, you learn how to move files or folders on the remote 
server. Note that this is only possible, if you have the necessary 
access rights. 

To move a file, do as follows: 

1. From the Remote System window, select file and drag-and-

drop it on the target directory. The directory has to be on the 

same server. 

Or: 

2. Right-click on selected file in the Remote System window, 

and choose option Move to folder from the pop-up menu   

3. Then select the directory to which you wish to move the file. 

 

To move folders, follow these steps: 

1. From the Remote System window, select folder and drag-

and-drop it on the target directory. The directory has to be on 

the same server. 

Or: 

2. Right-click the folder you want to move and choose Move 

folder to from the pop-up menu. 

3. Then select the directory to which you wish to move the 

folder.   

 

Now that you have learnt how to move files or folders, you get to 
know how to delete files or folders in the next section.  
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Deleting files or folders 

In this section, you learn how to delete files or folders on the remote 
server. Please note that this is only possible if you have the necessary 
access rights. 

To delete files, do as follows: 

1. From the Remote System window, select the item you wish 

to delete. 

2. Then click Delete.  

 

To delete folders on the remote server, follow these steps: 

1. Select folder and choose option Delete Folder from the 

Commands menu. 

2. If no folder is selected when clicking Delete Folder, you are 

prompted to type in a folder name. 

NOTE: If a folder contains files, you may only delete it, when option 
Allow deletion of directories containing files is selected from 
the Options dialog box, Advanced tab. 

 

In the next section, you learn how to create a new folder. 

 

Creating folders 

In this section, you get to know, how to create a new folder on the 
remote server. Please note that you need the required access rights 
for creating a new folder. 

To create a new folder, do as follows: 
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• From the Commands menu, select New Folder and type in 

the desired name. 

Or: 

• Right-click on the upper directory tree of the remote system 

and select New Folder from the pop-up menu. 

 

See in the next section how to print the content of folders. 

 

Printing folders 

In this section, you learn how to print the content of a folder: 

1. Select folder and choose option Folder Content from the 

Commands menu. 

2. Then the content of the folder is displayed. 

3. Save the content of the folder in a text file or copy it to 

clipboard. 

4. Then you can print the text file or paste the content to 

another program (e.g. Word).  

 

This completes the tutorial. You now know the most important 
functions of WISE-FTP. If you have questions concerning the 
functions, or if you are interested in further program functions, refer to 
the Online help or your manual. 

 



 

53 

Meaning of reply codes 

Reply codes 
In this chapter you find an overview of the most important reply codes 
which might appear in the FTP log. These three digit codes indicate the 
following, depending on their first digit: positive reply, successful 
action, positive temporary reply, temporary negative reply, permanent 
negative reply. In the next sections, you find all reply codes possible, 
sorted by their first numbers.  

 

1xx - Positive reply 

The following reply codes point to a successful beginning of an action. 
However, the client waits for further replies before going on. 

• 110 Restart marker reply 

• 120 Service ready in nnn minutes  

• 125 Data connection already open; transfer starting 

• 150 File status okay; about to open data connection 

 

2xx - Successful actions 

These reply codes hint to successful completion of an action. The client 
may run another command. 

• 200 Command okay 

• 202 Command not implemented, superfluous at this 

site 

• 211 System status, or system help reply 

• 213 File status 

• 214 Help message 
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• 215 NAME system type, where NAME is an official system 

name from the list in the Assigned Numbers document. 

• 220 Service ready for new user 

• 221 Service closing control connection. Logged out if 

appropriate 

• 225 Data connection open; no transfer in progress 

• 227 Entering Passive Mode (h1,h2,h3,h4,p1,p2) 

• 230 User logged in, proceed 

• 250 Requested file action okay, completed 

• 257 "PATHNAME" created  

 

3xx - Positive temporary reply 

The following reply codes tell you that the command was executed 
successfully. However, the server requires further information about 
the client, to complete the action. 

• 331 User name okay, need password 

• 332 Need account for login 

• 350 Requested file action pending further information 

 

4xx - Temporary negative reply 

The following reply codes signify that the command could not be 
executed. However, this error is temporary. This command will 
possibly be executed successfully when trying again. 

• 421 Service not available, closing control connection  
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• 425 Can't open data connection 

• 426 Connection closed, transfer aborted 

• 450 Requested file action not taken. File unavailable 

• 451 Requested action aborted 

• 452 Requested action not taken. Insufficient storage 

space in system 

 

5xx - Permanent negative reply 

These reply codes show you that the command could not be executed. 
This is a permanent error. If the command is executed again, the 
same error message will apear.  

• 500 Syntax error, command unrecognized 

• 501 Syntax error in parameters or arguments 

• 502 Command not implemented 

• 503 Bad sequence of commands 

• 504 Command not implemented for that parameter 

• 530 Not logged in 

• 532 Need account for storing files 

• 550 Requested file action not taken. File unavailable 

• 551 Requested action aborted: page type unknown 

• 552 Requested file action aborted. Exceeded storage 

allocation (for current directory or dataset) 
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• 553 Requested action not taken. File name not allowed 

 

Frequent reply codes  

In the following you find frequently appearing reply codes and their 
origins: 

• 150: For an FTP connection two ports are used: 21 for 

sending commands, and 20 for sending data. This reply code 

points to the server reconnecting to connection 20 for the 

data transfer.  

• 230: This reply code appears, after the appropriate password 

was sent. This means that the user login was successful. 

• 331: This reply code appears, after the user name was sent. 

It is always the same reply code that appears, no matter if 

the user name is valid on the system or not. 

• 426: Data connection is established to proceed an action. The 

action was aborted and the data connection was closed. 

• 530: This reply code signifies that the user cannot log in, 

because user name and password are invalid. Your user 

account password has possibly been misspelled or the server 

is set up for anonymous access only.  

• 550: The command cannot be executed, because the 

specified file does not exist. This reply code appears if a file 

that is not available on the system is requested via GET or if, 

using PUT, a file was created in a folder for which you lack the 

necessary access rights. 
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Troubleshooting 

Problems during connection 

PROBLEM SOLUTION 

Error message: Unable to 
connect to FTP server. 

• Check whether you are 

connected to the 

Internet. WISE-FTP 

cannot establish a dial-

up connection by itself. 

It uses the dialer 

defined in the file 

winsock.dll (e.g. "Dial-

up Network").  

• If you are using a proxy 

server or firewall, make 

sure you have 

configured them 

correctly in the Options 

menu.  

• Check your user 

name/password 

combination. 

 

Connection to remote server is 
suddenly closed. 

• Some servers 

disconnect 

automatically after a 

certain period of time if 

they do not receive 
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commands from the 

client. This helps to 

avoid that server 

performance is reduced 

unnecessarily. The 

server never 

disconnects if a transfer 

is active. It only 

disconnects if client and 

server have not 

communicated for a 

certain period of time 

defined by the server 

administrator.  

• A further reason may 

be the configuration of 

WISE-FTP. Check Hold 

connection at idle 

under 

Options/Advanced.  

Error message: "500 No route to 
host: Winsock error # 10065" 

• Verify if you are 

connected to the 

Internet. 

• Verify if there is a 

firewall which has not 

been set up correctly. 

• Verify if there is a 
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software firewall (like 

e.g. Norton Internet 

Security) which blocks 

the access. 

 

 

Problems during file transfer 

PROBLEM SOLUTION 

Some of the transferred files are 
defective. 

• One reason might be 

that you have 

transferred the files in 

ASCII mode. This may 

cause errors with some 

file types. Only use 

ASCII mode, if you 

transfer plain text 

documents (e.g. .txt, 

.htm, .html, .cgi, .php). 

All the other files must 

be transferred in binary 

mode.  

• If the problems 

persists, make sure you 

activated data flow 

control of the modem. 

To do so, click Start / 

Settings / System 
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Control / Modem. 

After files were uploaded 
successfully, the website is not 
found on the Internet. 

• Verify if you have 

uploaded the HTML 

document to the root 

directory. This directory 

is the top directory of 

your webserver and is 

displayed as "/".  

• Your start file is not the 

file index.html, or the 

file name is not written 

in lowercase.  

• Verify if you have set 

sufficient access rights 

on the files. In WISE-

FTP you can assign 

access rights by right 

clicking a file and 

selecting option 

Properties. For HTML 

documents it is 

sufficient to set the 

value 644. 

 

Error message "Error 404" • Your start document is 

not index.html or the 

file name is completely 
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written in lowercase.  

• You have placed your 

website or start file 

index.html into a 

subfolder. Move the file 

to the root folder of 

your webserver. In 

most of the cases this is 

the folder on top of an 

FTP server.  
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